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About this document 
This document shows you how to use IBM® CICS® Performance Analyzer for z/OS® (CICS PA) to get 
CICS statistics or performance data into a comma-separated value (CSV) file or a DB2® table. It then 
presents example scenarios for using that data to create reports and charts. 

The example scenarios serve two purposes. First, they create reports or charts that help answer 
common CICS performance-related questions. Second, they demonstrate different tools and 
techniques. 

Scenario 1. Are we meeting service-level agreements? 

Creates bar charts of CICS transaction response times compared to an SLA value. 

This scenario uses a Microsoft Office Excel 2016 for Windows (Excel) macro to query a CSV file or 
z/OS-based DB2 tables, and then create a set of bar charts. 

Scenario 2. Why is a transaction slow? 

Creates bar charts of a variety of CICS performance data for selected CICS transactions. 

This scenario uses an Excel macro to create bar charts from a CSV file. 

Scenario 3. Tuning LSR buffer pools 

Creates a tabular report of local shared resource (LSR) buffer pool statistics. 

This scenario uses DB2 Query Management Facility™ (QMF™) for z/OS to query DB2 tables and 
then format the results. 

Scenario 4. Comparing current and previous CICS performance 

Creates a spreadsheet that compares "before" and "after" performance data summary extracts, 
with percentage differences highlighted in shades of red (for increased values) or green (for 
decreased values). 

This scenario uses an Excel add-in to create a workbook from two CSV files. 

Scenario 5. Threadsafe performance issues: TCB CPU usage and change modes 

Creates bar charts of average response times, CPU times, and TCB mode switches for each 
transaction ID in a performance data summary extract. You can click a bar (representing a 
transaction ID) to display a pie chart of TCB mode usage for that ID. You can also set warning 
thresholds to highlight IDs with long response times or high numbers of TCB mode switches. 

This scenario also creates an interactive timeline chart of a performance data list extract, 
enabling you to pan and zoom a time-based chart of detailed threadsafe-related CICS 
performance data (or any CICS performance field). 

This scenario uses Excel add-ins to create charts from CSV files. 

Scenario 6. Transaction statistics 

Creates an interactive timeline chart of transaction statistics extracted from a statistics HDB. This 
also demonstrates how to add "derived", formula-based columns to a timeline chart: that is, 
columns whose values are defined by formulae that refer to the values of other columns. 

This scenario uses Excel add-ins to create charts from CSV files. 

While these scenarios are designed to be useful in themselves, they are intended to be a starting 
point for your own custom reports and charts. 
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What you should already know 
You should be familiar with CICS statistics and performance data, and you should know how to use 
the SMF dump program (IFASMFDP) to dump SMF data sets; or at least, know where to find the 
offline SMF data sets on your system. 

You should have a basic understanding of the CICS PA ISPF dialog, which you can get by completing 
the CICS PA Getting Started Guide, SC34-7468-00. In particular, you should be able to perform the 
following tasks:  

• Start the CICS Performance Analyzer ISPF dialog  

• Define CICS systems and files  

• Run a Report Set  

• Run an individual report  

• View report output  

Preferably, you should have an idea or a requirement for a "custom" CICS statistics or performance 
report: that is, a report not already provided by CICS PA. You should know which statistics or 
performance records you need (and in which SMF files they are stored), and have an idea of what 
you want the report to look like (for example, do you want a tabular report or a graphical chart?). 

To work with Excel, you should know how to view and run Excel macros. 

If you plan to work with DB2 tables, then you should understand basic DB2 concepts and techniques, 
such as how to query DB2 tables with SQL SELECT statements. 

If you want to automate tasks in Windows, then you will need basic knowledge of Windows scripting 
using Visual Basic Scripting Edition (VBScript). 
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Related information 
Product or concept URL 

CICS Transaction 
Server (TS) 

https://www.ibm.com/support/knowledgecenter/SSGMGV/welcome.html 

CICS PA https://www.ibm.com/support/knowledgecenter/SSPPU4/welcome.html 

CICS Transaction 
Gateway (TG) 

https://www.ibm.com/support/knowledgecenter/SSZHJ2/welcome.html 

DB2 https://www.ibm.com/support/knowledgecenter/SSEPGG 

z/OS https://www.ibm.com/support/knowledgecenter/SSLTBW 

Excel macro 
programming 

In the Excel Help, see Automate tasks with Visual Basic macros 

Table 1. Related information 
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Download the sample files 
You can download the code for the example scenarios from the same Web site you downloaded this 
document: 

Appendix C, "List of supplied sample files" describes each of these sample files. 
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Disclaimer 
The scenarios and sample code are provided to you solely for the purpose of assisting you to create 
your own reports and charts. 

IBM and its suppliers and licensors disclaim all warranties, either express or implied, in such 
scenarios and sample code, including the warranty of non-infringement and the implied warranties 
of merchantability or fitness for a particular purpose. In no event will IBM or its licensors or suppliers 
be liable for any damages arising out of the use of or inability to use the scenarios and sample code. 

In no event shall IBM or its licensors and suppliers be liable for any lost revenue, lost profits or data, 
or for direct, indirect, special, consequential, incidental or punitive damages, however caused and 
regardless of the theory of liability, even if IBM or its licensors or suppliers have been advised of the 
possibility of such damages. 



 

12    SupportPac CP12: Charting Historical CICS Performance Data 

System requirements 
• IBM CICS Performance Analyzer for z/OS V4.1 or a later version. 

• The supplied Windows script (.wsf and .vbs) and batch (.bat) files have been tested with 
Microsoft Windows 10. 

• Microsoft Excel 2010 or a later version. The supplied Excel macros and add-ins have been tested 
with Excel 2010 and Excel 2016. Unless indicated otherwise, instructions in this document for 
performing actions in Excel refer to the Excel 2016 user interface. 

• The supplied QMF objects have been tested with DB2 QMF for z/OS V11.1 

• DB2 processing features have been tested with DB2 V11.1 
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Summary of changes 
June 2017 
The macros are updated to work with Excel 2010 and 2016, taking account of changes in the Excel 
object model that have occurred since Excel 2003. Previously, several of the scenarios would not run 
correctly in Excel 2010 or Excel 2016; now they all run correctly. 

Scenario 1 has been changed so that you have the option of taking input from a CSV file or from DB2, 
instead of solely from DB2. It now also handles long-running transactions with a task termination 
count of zero whereas previously these could cause a 'divide by zero' macro error. 

Scenario 5 has been amended to take account of changes in CICS TS 4.1, 4.2, and 5.1. That is: 

• The charts now show T8 CPU Time (if there is any T8 CPU Time). 

• If J8 CPU Time or J9 CPU Time fields are present in the CSV extract, there is no error, but those 
fields are not shown in the charts. 

The documentation for Scenario 6 now states that you must refer to cells in formulas by cell 
reference, such as B1 rather than by label, such as ‘Current MAXTASK’. This is necessary because the 
Accept labels in formulas option was removed in Excel 2007. 

To take account of changes to the Excel menus, toolbars, and ribbon in recent versions of Excel, you 
can now run the macros by clicking a button in the CP12 group on the Home tab in Excel. 

All files are now provided in the most up-to-date file format: .xls files are now provided as .xlsx or 
.xlsm files, and .xla files are provided as .xlam files. 

March 2008 

Enhancements to the CICS PA Timeline Chart Excel add-in: 

• Support for data that crosses date boundaries (previously, this add-in could only chart data 
within a single day). 

• AutoFilters on the Data sheet. You can now filter charts by one or more column values. For 
example, when charting CICS statistics, you can limit the chart to show only the INT interval 
types for a particular application ID. The active filter details appear in the chart title. 

• Mouseover on chart data points. When you move your cursor over a data point or line on a 
chart, a text box appears with details of the corresponding data row. 

This add-in is described in "Scenario 5. Threadsafe performance issues: TCB CPU usage and change 
modes". 

February 2008 

New Excel add-ins 

This update includes three new Excel add-ins for working with data from CICS PA: 

CICS PA Compare Before-After Excel add-in 

Compares two CICS PA performance data summary extracts, using colors to indicate differences 
in corresponding cells: increases in shades of red, decreases in shades of green. This add-in is 
described in "Scenario 4. Comparing current and previous CICS performance". 
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CICS PA TCB Mode Analysis Excel add-in 

Creates charts of task control block (TCB) usage per CICS transaction code. Requires a CICS PA 
performance data summary extract that has been generated using the CICS PA supplied sample 
summary report form CPU3SEXT. 

This add-in is described in "Scenario 5. Threadsafe issues: TCB CPU usage and change modes". 

CICS PA Timeline Chart Excel add-in 

Creates an interactive timeline chart of a CICS PA or statistics data extract. This add-in is also 
described in "Scenario 5. Threadsafe performance issues: TCB CPU usage and change modes". 

For a comparison of using Excel add-ins (.xla files) and using macros in workbooks (.xls files), see 
"Installing the CICS PA Compare Before-After Excel add-in". 

DB2 names for CICS statistics: updated for CICS TS V3.2 and CICS TG V7.1 

The tables in Appendix D, "DB2 names for CICS statistics" have been updated to show CICS 
Transaction Server V3.2 statistics and CICS Transaction Gateway V7.1 statistics. 

December 2005 

First release, titled "CP12: Historical Database Reporting".
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Part I. Introduction 
The following topics present a brief overview of CICS PA. It also explains how you can get 
performance and statistics data into a CSV file or into DB2 so you can create charts based on the 
data.  

If you are already familiar with these concepts, then skip to Part II, " Example scenarios and custom 
reports ". 
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What is CICS PA? 
CICS PA is a reporting tool that provides information on the performance of your CICS systems and 
applications, and helps you tune, manage, and plan your CICS systems effectively. CICS PA also 
provides a historical database (HDB) facility to help you manage CICS statistics and performance data 
for your CICS transactions. 

CICS PA is not an online monitoring tool. It produces reports and extracts using data normally 
collected by your system in MVS™ System Management Facility (SMF) data sets: 

• CICS Monitoring Facility (CMF) performance class, exception class, and transaction resource class 
data in SMF 110 records 

• CICS Transaction Server statistics data in SMF 110 records 

• CICS Transaction Gateway statistics data in SMF 111 records 

• System Logger data in SMF 88 records 

• DB2 accounting data in SMF 101 records 

• WebSphere® MQ accounting data in SMF 116 records 

• IBM Tivoli® OMEGAMON® XE for CICS on z/OS (OMEGAMON XE for CICS) data in SMF 112 
records, containing transaction data for Adabas, CA-Datacom, CA-IDMS, and Supra database 
management systems 
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Charting CICS statistics or performance data 
The following figure illustrates how to get CICS statistics or performance data into a chart. There are 
several possible pathways: 

• SMF to CSV to Excel chart 

• SMF to HDB to CSV to Excel chart 

• DB2 table to custom report via an SQL query 

• DB2 table to Excel via ODBC 

Note: You can load CICS performance and statistics data into DB2 via an HDB. 

 

Figure 2. Using CICS PA to get CICS statistics or performance data into a DB2 table or a CSV file 

Chart
Spreadsheet

Report

Tape

SMF data sets

CICS
Performance
Analyzer

Windows

ODBC

Extract

SQL 
query

Load

Export

z/OS

File transfer

DB2
QMF

DB2 table

CSV data set

HDB register

HDB template

Report form

Report forms 
data set

Historical 
database 

(HDB)

SMF data sets

.csv file



 

18    SupportPac CP12: Charting Historical CICS Performance Data 

This document concentrates on how to get data from SMF files into a CSV file, and how to create 
charts in Microsoft Excel using the CSV file as a data source. Here is an overview of the steps 
involved.  

Refer to the CICS Performance Analyzer User’s Guide, SC34-7469-00, for more detail about the CICS 
PA-related steps. 

Defining CICS systems 

In CICS PA, the system (personal or shared) defines which SMF files to work with. 

If you have already defined the CICS systems that you want to work with, ignore this step. 

1. On the CICS PA primary option menu, either: 

• Select option 1 Personal Systems if you want to define CICS systems in your CICS PA 
personal profile library (a data set which is typically not accessible to other users), or 

• Select option 6 Shared Systems if you want to define CICS systems in an HDB register (a data 
set which is typically shared with other users) 

When you are learning to use CICS PA, and especially when you are experimenting with take-up, 
it is recommended that you define CICS systems in your personal profile library. You can then 
migrate them to shared system definitions later using take-up. 

A pop-up menu appears. 

2. Select Take-up from SMF File. 

The Data Take-Up from SMF pop-up window appears. (Why are we using take-up? Because 
take-up will define our systems automatically based on the contents of an SMF file.) 
 ┌────────────────────── Personal System Definitions ──────────────────────┐   
 │   File  Options  Help                                                   │   
 │ ──────────────────────────────────────────────────────────────────────  │   
 │                         Data Take-Up from SMF                           │   
 │ Command ===>                                                            │   
 │                                                                         │   
 │ Specify the SMF File for data take-up.                                  │   
 │                                                                         │   
 │ Data Set Name . . . 'MVS1.PROD.SMF'                                     │   
 │                                                                         │   
 │ Specify details if data set is not cataloged:                           │   
 │  UNIT  . . . . .           +       VOLSER  . . .         +              │   
 │  SEQ Number  . .      (1 to 255)                                        │   
 │                                                                         │   
 │ Execution Mode:                                                         │   
 │ 1  1. Submit Batch JCL                                                  │   
 │    2. Edit Batch JCL                                                    │   
 │                                                                         │   
 └─────────────────────────────────────────────────────────────────────────┘   

 

3. Press Enter to submit the take-up batch job. 
4. When the take-up batch job completes, the following pop-up window appears when you next 

invoke Personal System Definitions: 
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┌───────────────── Personal System Definitions ──────────────────┐ 
│                     Data Take-Up from SMF                      │ 
│ Command ===>                                                   │ 
│                                                                │ 
│         *********************************************          │ 
│         *             Take-Up from SMF              *          │ 
│         *********************************************          │ 
│                                                                │ 
│ CICS PA has completed extracting systems from the following    │ 
│ SMF File:                                                      │ 
│                                                                │ 
│ Data Set . . : 'MVS1.PROD.SMF'                                 │ 
│                                                                │ 
│ Instructions:                                                  │ 
│   Press ENTER to continue adding the systems.                  │ 
│   Enter DEFER command to defer adding the systems.             │ 
│   Enter END or CANCEL command to cancel adding the systems.    │ 
└────────────────────────────────────────────────────────────────┘ 

 

5. Press Enter to continue with the take-up. 
6. The pop-up menu appears again, with the message "Take-up was successful" in the top-right 

corner. 

 

Extracting to CSV 

To extract data to CSV format using CICS PA you can extract either from the SMF files defined in a 
personal or shared system, or from an HDB. This topic explains how to extract from the SMF files 
defined in a personal or shared system. 

1. Under option 2 Report Sets, enter NEW on the command line to create a new report set. 
2. Enter a name for the report set, for example EXT1. 
3. Press F8 to page down, and enter S beside Extracts > Performance or Extracts > Statistics. 

Which systems did this take-up define? 

If you take up definitions to your personal profile library, then you can view the objects and relationships 
that this defines either in the take-up job output, or via the dialog: 

1. On the CICS PA primary option menu, select option 1 Personal Systems. 

2. If a pop-up menu appears, then select “Maintain SMF Files”. Otherwise, if a list of systems appears, open 
the View menu, and then select Files. 

The list of known SMF files appears. (The Use column shows the number of systems that take-up found 
in each SMF file or that you have subsequently manually defined.) 

3. Enter S next to the SMF file for which you have just performed the take up. 

A list of systems appears. 

4. To see a list of the CICS systems that take-up found for an MVS image, enter S next to the image name. 
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 EDIT                      Report Set - EXT1                       Row 33 of 44 
 Command ===>                                                  Scroll ===> PAGE 
                                                                                
 Description . . . CICS PA Report Set                                           
                                                                                
 Enter "/" to select action.                                                    
                                                                                
              ** Reports **                           Active                    
                   DB2                                  No                      
                   WebSphere MQ                         No                      
                   OMEGAMON                             No                      
      -       System Reports                            No                      
                   System Logger                        No                      
      -       Extracts                                  No                      
                   Cross-System Work                    No                      
              S    Performance                          No                      
                   Record Selection                     No                      
                   HDB Load                             No                      
                   System Logger                        No                      
                   Statistics                           No                      
              ** End of Reports **                                              

 

4. Fill in the details of the extract. Some noteworthy fields are: 

a. Data Set Name. The name of the extract CSV data set, for example ABC.PERFEXT.CSV 
b. Form. The form defines the fields to extract. If there isn’t already a form with the fields 

you want, under option 3 Report Forms you can create a new form with precisely the 
desired fields, or use Save As to save an existing form which has almost the fields you 
need, and then edit it. 

Note: If you choose primary menu option 3 Report Forms and select the Samples menu, 
you can populate your report forms data set with sample report forms. 

c. Interval. To summarize data to every hour, set this to 01:00:00. To summarize to every 
minute, set this to 00:01:00. 

d. Include Field labels. Select this to ensure that you have fields labels in the CSV and the 
charts 

e. Numeric Fields in Float format. Do not select this if you are intending to use the CSV as a 
data source for a chart. This option is used only when importing the CSV into DB2. 

f. Delimiter. set this to a comma character. 
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                         BB1 - Performance Extract                               
 Command ===>                                                                    
                                                                                 
 System Selection:                       Extract Recap:                          
  APPLID . .           +                  DDname  . . . EXPT0001                 
  Image  . .           +                                                         
  Group  . .           +                                                         
                                                                                 
 Output Data Set:                                                                
  Data Set Name  . . ABC.PERFEXT.CSV                                             
  Disposition  . . . 1  1. OLD   2. MOD   (If cataloged)                         
                                                                                 
 Extract Focus:                          Summary Processing Options:             
  Form  . . . . CPUSUM    +               Interval  . . . 01:00:00  (hh:mm:ss)   
  Alert . . . .           +               Override Form             +            
   Severity . .           +               Timestamp . . .           +            
                                                                                 
 Extract Format:                                                                 
  /  Include Field Labels                                                        
     Numeric Fields in Float format                                              
  Delimiter . . ,                                                                
                                                                                 
 Selection Criteria:                     Execution Options:                      
     Performance                          /  Use External Sort                   
                                                                                 
 Repository  . . : CPA540.WABC.RSSAMP.REPOSTRY                                   

 

For a Statistics Extract, the fields are similar. To specify the fields to extract, you can specify a 
form, or alternatively select the Statistics Reports option to use the fields of one of the supplied 
statistics reports. 

5. Enter F3 and F3 again to save the report set. 
6. Run the report set, and in the run options, specify the system and the report interval to report 

on. 

The extract CSV data set is created on z/OS. 

 
The following topics in the CICS PA User’s Guide describe CSV extraction in more detail: 

• Performance Data extract 

• Statistics extract 

• Extracting Performance HDB data to CSV 

• Extracting Statistics HDB data to CSV 

Copying a CSV data set to Microsoft Windows 

Several of the CP12 scenarios expect a CSV file available on Windows. “Appendix A Transferring CSV 
files interactively” explains how to copy a CSV data set to Windows, and how to ensure that the CSV 
file is correctly encoded for Windows. 

You don’t have to follow that exact procedure if you already have a preferred method for copying 
CSV files to Windows, and ensuring they are correctly encoded. 

Tips for extracting CSV files 

A quick way to extract all data is to specify -9999 as the “from” date (to start extracting records from 
9999 days ago), and 0 (today) as the “to” date. 
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Opening CSV files in Excel 

If you open a CSV file created by CICS PA in Excel, Excel does not always recognize the date and time 
values, or does not format them correctly: 

Format of start times 

CICS PA statistics data extracts contains interval start times in the first column as a combined 
date/time value in the format "yyyy-mm-dd-hh.mm.ss". Excel does not recognize this format as a 
date/time. (One clue that Excel has not recognized a date/time is that the value appears left-aligned; 
by default, Excel shows date/time values right-aligned.) 

Here is one solution: 

1. Insert a new column next to the existing "Start Time" column. 
2. Copy the column heading text "Start Time" to the first row of the new column. 
3. Enter the following formula into the second row of the new column: 

=DATEVALUE(LEFT('Start 

Time',10))+TIMEVALUE(SUBSTITUTE(RIGHT('Start Time',8),".",":")) 

Note: To use column headings such as 'Start Time' as a cell reference, you must have set the 
Excel option to allow labels in formulas: Tools > Options > Calculation > Accept labels in 
formulas. Otherwise, use a cell reference such as B2. 

This formula converts the text from the original column into a numeric Excel serial date/time 
value, where the integer portion (returned by the DATEVALUE() function) represents the date 
and the fractional portion (returned by the TIMEVALUE() function) represents the time of day. 

Next, we want to format this numeric value as a readable date/time. 

4. Select the cell where you have just entered the formula, and then click Format > Cells... > 
Number > Category: Custom > Type: yyyy-mm-dd hh:mm:ss (you will need to enter this format, 
unless it is already in the list) > OK 

The formula result in the selected cell now appears as a formatted date/time. Next, we want to 
populate the rest of the cells in the column with this formula and format. 

5. Double-click the fill handle (the small black square in the bottom right corner) of the selected 
cell. This copies the formula and format to all used rows in the sheet. 

Next, we want to replace the formula in each cell with the formula result; this removes the 
dependency on the original column, which we will then delete. 

6. Select the entire new column (for example, by clicking the column header). 
7. Click Edit > Copy 
8. Click Edit > Paste Special... > Paste: Values > OK 

This pastes the column contents back onto itself; but as values, not as formulas. 

9. Delete the original column. 

Seconds to three decimal places 

CICS PA performance data extracts contain the time portion of timestamp fields in the format 
"hh:mm:ss.000"(that is, with fractions of seconds to three decimal places). Excel recognizes this field 
as a time, but incorrectly recognizes its format as "mm:ss.0" (no hour portion, and with seconds to 
only a single decimal place). In this case, all we have to do is change the cell formatting: 
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1. Select the first cell under the column heading. 
2. Press Shift+Ctrl+down arrow to extend the selection to the last used row. 
3. Click Format > Cells... > Number > Category: Custom > Type: hh:mm:ss.000 > OK 

Separate columns for date and time 

CICS PA performance data extracts contain the date and time portions of timestamp fields in two 
separate columns, such as "Start Date" and   "Start Time". You might find it useful to combine these 
values into a single column; for example, for charting. To do this, insert a new column that uses a 
formula to add the date/time serial values of the two columns: 

   ='Start Date'+'Start Time' 

and then set the cell format of the new column to "yyyy-mm-dd hh:mm:ss.000". 
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Historical Databases 
Historical databases are data sets created by CICS PA that contain required CICS performance or 
statistics data from SMF files. There are 3 types of HDB:  

• Performance List. Typically, you use List HDBs to analyze recent transaction events. 

• Performance Summary. Typically, you use Summary HDBs for long-term trend analysis and 
capacity planning. 

• Statistics. Contains collections of CICS Transaction Server and CICS Transaction Gateway 
statistics over a specified time interval. 

You can extract data from an HDB to CSV using option 5.6 Historical Database > Extract. 

Differences in a CSV extracted from HDB or from SMF 
Be aware that the TRAN field has 4 characters when exported from an SMF file, for example “CEMT”, 
and when TRAN is exported from an HDB, it has 8 characters and is padded on the right with spaces, 
for example “CEMT   ”. 

If you combine or compare data from an HDB and an SMF file, Excel does not recognize “CEMT” and 
“CEMT    ” as the same transaction ID. 
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DB2 
You can set Excel to use a DB2 table as its data source, and then create charts from it. However, to 
establish a successful connection to DB2 you need to: 

1. Install IBM Data Server Client, or a similar client product, on your Windows computer, and apply 
a valid DB2 Connect™ license.  

2. Create an ODBC data source to DB2 on your Windows computer. 

Scenario 1 of CP12 shows you how you can use DB2 in this way. 

Installing and licensing IBM Data Server Client 
1. Install IBM Data Server Client.  

At the time of writing, the most current version is IBM Data Server Client V11.1 (CNB0TML). You 
need an IBM ID to download this product. If you do not have an IBM ID you can sign up to 
receive one on the download page. IBM Data Server Client provides the DB2 ODBC driver. 

2. Obtain a valid DB2 Connect license file and copy it to the license folder of your DB2 client 
product. 

The license folder for IBM Data Server Client V11.1 (CNB0TML) is C:\Program 
Files\IBM\SQLLIB\license. 

See the information about DB2 license files in IBM Knowledge Center for more details. 

3. Apply the DB2 Connect license file. 

See the information about Applying DB2 licenses in IBM Knowledge Center for more details. 

Creating an ODBC Data Source for DB2 

To set up the ODBC data source, you need to know some DB2 details that you can find on your z/OS 
system by browsing the DB2 job log for message DSNL004I. 

------------------------------------------------------------------------ 
   DSNL004I  - DDF START COMPLETE            

              LOCATION  LOC1               
               

              DOMAIN    prod.system.priv   

              TCPPORT   446                
              RESPORT ... 
Note: If the DB2 job log does not contain this message, it means that the Distributed Data Facility 
(DDF) has not been set up on your system. Contact your DB2 system administrator. 

Write down the values of the following items: 

Item Write the value for your system here 
 Location  

 Domain  

 Port (TCPPORT number, not the RESPORT number)  
Table 2. Your DB2 Job Log Details 

1. Click the Start button and type ODBC. 
2. Choose ODBC Data Sources 32 bit. 
3. On the System DSN tab of the ODBC Data Source Administrator, click Add. 

1 

2 

3 

1 

2 

3 

https://www-01.ibm.com/support/docview.wss?uid=swg21385217
https://www.ibm.com/support/knowledgecenter/en/SSEPGG_11.1.0/com.ibm.db2.luw.qb.server.doc/doc/r0006748.html
https://www.ibm.com/support/knowledgecenter/en/SSEPGG_11.1.0/com.ibm.db2.luw.qb.server.doc/doc/t0023608.html
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The details of the DB2 data source are: 

• Driver: IBM DB2 ODBC DRIVER 
• Data Source Name: <your choice> 
• Database name: <Location> 
• Host name: <Domain> 
• Port number: <Port> 
• User ID : <Your user ID for z/OS> 
• Password: <Your password for z/OS> 

4. On the System DSN tab, select the ODBC data source, and click Configure. 
5. Click the Connect button to test whether Windows can connect to DB2 with basic connectivity. 

The message “Connection tested successfully” indicates a successful basic connection. 

Testing the connection from Excel to DB2 

If you have set up the connection successfully, this test returns data to Excel from a DB2 table. 

1. In Excel, open either a new blank workbook or the supplied sample file "Query zOS-based DB2 
table.xlsm". 

2. Start the Visual Basic Editor in Excel (select Tools > Macro > Visual Basic Editor). 
3. If you opened a new blank workbook, copy the following code into the editor (omit the 

highlighted annotation numbers): 

   Sub QueryDB2() 
       ' Define site-specific details 

       Const conLocation = "location"  

       Const conDomain = "domain"  

       Const conPort = "port"  
       ' Define user-specific details 

       Const conTSOUserID = "TSO user ID"  

       Const conTSOPassword = "TSO password"  
       Dim strSQL, strConnection 
       ' Define connection string 
       strConnection = "ODBC;driver={IBM DB2 ODBC DRIVER}" & _ 
                       ";Database=" & conLocation & _ 
                       ";hostname=" & conDomain & _ 
                       ";port=" & conPort & _ 
                       ";protocol=TCPIP" & _ 
                       ";uid=" & conTSOUserID & _ 
                       ";pwd=" & conTSOPassword 
       ' Define SQL query 

       strSQL = "SQL SELECT statement"  
        
       ' Add QueryTable to active worksheet; 
       ' populate worksheet with query results 
       ActiveSheet.QueryTables.Add(Connection:=strConnection, _ 
         Destination:=Range("A1"), Sql:=strSQL).Refresh 
   End Sub 

Figure 1. Excel VBA procedure: querying a z/OS-based DB2 table 
4. Replace the placeholder values in the previous listing with actual values: 

• , ,   The values from the DSNL004I message in the DB2 job log. 
• ,   Your TSO user ID must be authorized to access the DB2 tables you want to query. 

1 

2 

3 

4 

5 

6 

1 2 3 

4 5 
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To test whether your user ID has the appropriate authority, log on to TSO/ISPF with this user 
ID, and then use QMF or the DB2 for z/OS SPUFI utility to perform the query. If you can 
perform the query using QMF or SPUFI, you can perform the query using this method, too. 

•  The SQL SELECT statement, such as: 

SELECT * FROM table-name 

5. Run the QueryDB2 procedure (click the Run toolbar button in the Visual Basic Editor window). 

The results of the SQL query appear in the active worksheet. 

For an example of how to use this technique to create charts, see "Scenario 1. Are we meeting 
service-level agreements?".

6 
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Part II. Example scenarios and custom reports 
The following example scenarios show you how to answer typical questions about CICS performance 
by creating reports and charts from DB2 tables or CSV files exported by CICS PA. 
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Scenario 1. Are we meeting service-level agreements? 
Suppose that you are the manager of an information technology department that runs CICS systems. 
You are responsible for ensuring that the performance of the CICS systems meet the terms of a 
service-level agreement (SLA) with your customers. For example, your SLA specifies that, for "peak" 
hours such as 8am to 5pm, the average response time for business-critical transactions must be 
under a certain limit. 

To avoid penalties, you want daily charts of transaction response times: 

• Averages for all transactions, by peak hour 

• Averages for each transaction, by peak hour 

The following figures show examples of the charts created by the supplied Excel macro: 

 

Figure 2. Service-level agreement chart: average response time for all transactions, by peak hour 
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Figure 3. Service-level agreement chart: average response time for a single transaction, by peak 
hour 

Example charts are also supplied in the file "CICS charts - scenario 1 -example.xls". 

Preparing the data for the charts 

This scenario has been designed to give you the choice of CSV or DB2 data sources. The CSV option is 
the simplest, and a sample CSV file, CICS PA scenario 1.csv, is provided. These procedures explain 
how to prepare the data for CSV and DB2. 

Creating an Extract CSV file for Scenario 1 
1. Define a performance summary report form in CICS PA with the key fields: START, MVSID, 

APPLID, TRAN, and other fields TASKTCNT, RESPONSE with function AVE, and RESPONSE with 
function TOT. 

                     EDIT SUMMARY Report Form - SCEN1      Row 1 of 393 More: >  
 Command ===>                                                  Scroll ===> CSR   
                                                                                 
 Description  . . . Summary Report Form               Version (VRM): 700         
                                                                                 
 Selection Criteria:                                                             
     Performance  *                                   Page width . . 132         
                                                                                 
     Field    Sort                                                               
 /   Name +   K  O Type    Fn   Description                                      
     START    K  A TIMES        Task start time                                  
     MVSID    K  A              MVS SMF ID                                       
     APPLID   K  A              CICS Generic APPLID                              
     TRAN     K  A              Transaction identifier                           
     TASKTCNT                   Total Task Termination count                     
     RESPONSE              AVE  Transaction response time                        
     RESPONSE              TOT  Transaction response time                        
     EOR                        ---------------- End of Report ----------------  
     EOX                        ---------------- End of Extract ---------------  
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Next, you extract from wherever the data is stored, either an SMF file or DB2. 

2. To extract from an SMF file: 

a. Select option 2 Report Sets. 
b. Select a report set. 
c. Under Extracts, select Performance. 
d. Fill in the details of the extract, especially Data Set Name, Form, an Interval of 01:00:00, 

Include Field Labels, and specify a comma delimiter. 

3. To extract from an HDB 

a. Select option 5.6 Historical Databases > Extract. 
b. Select the historical database. 
c. Fill in the details of the extract, especially Data Set Name, Form, a Time Interval of 

01:00:00, Include Field Labels, and specify a comma delimiter. 

4. Transfer the CSV data set to Windows in ascii mode. “Appendix A Transferring CSV files 
interactively” explains one method of doing so. 

Loading data to DB2 when you plan to use DB2 as a data source 

This procedure is useful when you plan to use DB2 as a data source. 

1. In the CICS PA dialog, define an HDB summary template with the following four key fields, in this 
order: 

• START 
• MVSID 
• APPLID 
• TRAN 

followed by the non-key fields: 

• TASKTCNT 
• RESPONSE 

Set the time interval to one hour (01:00:00). 

If you know that your SMF data includes long-running transactions whose response times you 
are not interested in, then specify performance selection criteria in the template to exclude 
those transactions. For example, to exclude transactions whose identifiers begin with the letter 
C: enter S in the template Performance field, and then enter "EXC", "TRAN", and "C*": 
       Inc  Field             --- Value or Range ---   Object 
    /  Exc  Name +    Type    Value/From   To          List + 
       EXC  TRAN              C*                                 
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                      EDIT Summary Template - SCEN1          Row 1 of 7 More: >  
 Command ===>                                                  Scroll ===> CSR   
                                                                                 
 Description  . . . Summary HDB Template              Version (VRM): 710         
                                                                                 
 Selection Criteria:                                                             
     Performance  *                 Time Interval  . . 01:00:00  (hh:mm:ss)      
                                                                                 
      Field                                                                      
 /    Name +    K  Description                                                   
      START     A  Task start time                                               
      MVSID     A  MVS SMF ID                                                    
      APPLID    A  CICS Generic APPLID                                           
      TRAN      A  Transaction identifier                                        
      TASKTCNT     Total Task Termination count                                  
      RESPONSE     Transaction response time                                     
      EOD          ---------------- End of HDB -----------------                 

 

2. Define a performance HDB using this template. 
3. Load the HDB with SMF data from the CICS systems that run the transactions you want to chart. 

Include time and count clock field components. 

                        Load SUMMARY HDB - SCEN1B                                
 Command ===>                                                                    
                                                                                 
 Specify HDB load options then press Enter to continue submit.                   
                                                                                 
 System Selection:                   ───── Report Interval ──────                
  APPLID . . *         +                  YYYY/MM/DD  HH:MM:SS.TH                
  Image  . .           +             From 2014/05/24  01:00:00.00                
  Group  . .           +             To   2014/07/24  23:59:59.00                
                                                                                 
 DB2 Export Options:                                                             
  /  Load DB2 Table                                                              
  Table Load Options                  Include Clock Field Components             
  2  1. Resume                        1  1. Time and Count                       
     2. Replace                          2. Time only                            
                                         3. Count only                           
  Statistics data VRMs to be loaded   Summary Options                            
   TS: 710      +      +      +          Include Sums of Squares                 
   TG: 920      +      +      +                                                  
                                                                                 
 Enter "/" to select option                                                      
 /  Edit JCL before submit                                                       

 

4. Export the HDB (either the entire HDB, or a selected period of data) to DB2. 
5. Set up the DB2 connection from your Windows PC to DB2. To do so: 

a. Install and license IBM Data Server Client (or a similar Windows-based DB2 product) on 
your PC. For details, see " Installing and licensing IBM Data Server Client". 

b. Create an ODBC data source for DB2. For details, see “Creating an ODBC Data Source for 
DB2”. 

c. Test the connection from Excel to DB2. For details, see “Testing the connection from 
Excel to DB2”. 

Enabling macros 
The Microsoft Excel files supplied with CP12 contain macros. It is likely that macros will be disabled 
in your organization by default. Two possible ways of enabling macros are: 

• Place “CICS charts - macros.xlsm” in a trusted folder before you open it. 
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In Excel 2016, select File > Options > Trust Center > Trust Center Settings > Trusted Locations to 
see the list of trusted locations. 

• Make “CICS charts - macros.xlsm” a trusted file before you open it. Select File > Options > Trust 
Center > Trust Center Settings > Macro Settings, and choose Disable all macros with 
notification. Then open “CICS charts - macros.xlsm” and choose Enable Macros when prompted. 

For more information about macro security, see the Microsoft Excel Help. 

Creating the charts 

To create these charts: 

1. Open the supplied file “CICS charts - macros.xlsm” in Excel, and run the macro 
SampleResponseSLAChartSet by doing one of the following: 

a. On the Home tab in the CP12 group, select Sample response SLA. 

 

b. Press F8, select SampleResponseSLAChartSet, and click Run. 

The macro displays a form prompting you for chart details. 

 

Figure 4. Excel form prompting for chart details and DB2 connection details 
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Fields Guidance 

Transaction IDs These are the transaction IDs for which you want to see charts. 

Date The date you are interested in. When the data source is DB2, the 
SQL query contains a clause WHERE START DATE = <this 
date>.  When the data source is CSV, the date is used only as the 
date to place in the title of charts; the CSV is not filtered based on 
date. 

From hour and To hour To get a chart covering the hours from 8am to 6pm, specify 8 as 
the "from" hour and 17 as the "to" hour (where 17 represents 
5pm; the start of the last hour that you want to chart, "5-6pm"). 

Service-level agreement 
response time 

Response times above this number of seconds will be highlighted. 

CSV or DB2 input You must select either CSV or DB2. The first time you run this 
scenario, select CSV and use the supplied CSV file, CICS PA scenario 
1.csv. Subsequently, you can create and use your own CSV file, or 
DB2 if you prefer. 

DB2 for z/OS connection See “Creating an ODBC Data Source for DB2” for the DB2 details. 

Table 3. Fields in Chart Response Time Form 
Be careful to specify valid argument values. For the sake of readability of the code, the supplied 
macro performs only limited error-checking on argument values. Invalid values can cause the 
macro to crash. 

2. Fill in the form, and click OK. 

The macro uses the details that you enter to create the charts, and then displays a Save As dialog 
box, prompting you to save the charts as an Excel workbook or a Web page.  

3. Save the Excel workbook containing the charts, or click Cancel on the Save As dialog box if you 
do not want to save it. 

Understanding the Excel macro 

To view the macro source in Excel: 

1. Open the file "CICS charts - macros.xlsm" (if it is not already open). 
2. Click Tools > Macro > Macros... > Visual Basic Editor 
3. In the Project window, expand the Modules folder, and then double-click the DB2Code module. 

The macro source appears in the main window area. 

The first procedure, SampleResponseSLAChartSet, is an example of a call to the procedure that does 
the actual work, ResponseSLAChartSet. The ResponseSLAChartSet procedure: 

1. Displays the form. 
2. Creates a new blank workbook. 
3. Calls the ResponseSLAChartByTran procedure to create a chart for each transaction. 
4. Calls the ResponseSLAChartAllTrans procedure to create the combined chart for all 

transactions. 
5. Calls the SaveOutput procedure (defined in the CommonCode module) to save the charts 

either as an Excel workbook or as a Web page. 
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The ResponseSLAChartByTran and ResponseSLAChartAllTrans procedures both call 
the CreateSLAChart procedure, which performs the following steps: 

1. Creates a new worksheet. 
2. Calls the importCSV procedure or the QueryDB2 procedure to get the data from CSV or DB2, 

and populate the worksheet with the results. 
3. Calls the CreateChart procedure (defined in the ChartCode module) to create the chart. 
4. Calls the DrawSLALine procedure to draw a horizontal line across the chart, indicating the SLA 

response time value. 

Note: A long-running transaction that did not terminate in a reporting period has a TaskTcnt value of 
0. To avoid ‘divide by zero’ errors, when the macro is calculating average response time, TaskTcnt is 
set to 1 for these transactions. 

Running the macro from scripts and batch files 

The supplied files include several other methods for running this macro: 

To run the macro without opening the Excel workbook: in Windows Explorer: 

• Double-click the supplied file "Run Excel macro.vbs". (To see how this script works, open it in a 
plain-text editor, such as Notepad.) 

To run the macro without any interactive prompts or messages: 

1. Open the supplied batch file "CICS charts - scenario 1.bat" in a plain-text editor. 
2. Edit the argument values on the wscript command line.  Specify values for all arguments. 

To set the macro to use a CSV file as input, set the csv parameter to the path name for the 
CSV file, and set the csvoption parameter to 1. 

3. Append the switch //B to the end of the command line. 
4. Save the file (to a new .bat file, if you like). 
5. Run the updated batch file (double-click it in Windows Explorer). 

This batch file calls a Windows script file, "CICS charts -scenario 1.wsf". The //B switch sets the value 
of the Windows script WScript.Interactive property to False. The Windows script uses this property 
to set the value of the blnInteractive argument for the ResponseSLAChartSet Excel macro, 
which creates the charts. The macro uses the value of the blnInteractive argument to determine 
whether to display interactive prompts. 

 

Terminating unwanted Windows script or Excel processes 

If a Windows script that calls an Excel macro crashes, then it may leave behind an orphan Excel process. 
To check for, and terminate, this process: 

Start the Windows Task Manager. To do this, either: right-click the Windows taskbar, and then select Task 
Manager, or press the key combination Ctrl+Alt+Del, and then click Task Manager. 

On the Processes tab, click the Image Name column heading. This sorts entries by image name. 

Look for an EXCEL.EXE process. Unless you have the Excel application open “deliberately” in a window, 
then any such process is an orphan left behind by the crashed Windows script. 

Click the EXCEL.EXE process and then click End Process. 

Similarly, if a Windows script hangs (for example in an endless loop) without actually crashing, you can 
terminate it by ending its wscript.exe process. 
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Scenario 2. Why is a transaction slow? 
Suppose that you are a CICS administrator for a large organization with thousands of CICS users. The 
help desk has forwarded complaints to you from users about slow response times from a particular 
CICS transaction. 

To begin analyzing the problem, and confirm that the problem exists, you want a summary of 
transaction performance data for the relevant time interval: 

• Response time 

• CPU time 

• Suspend time 

• Dispatch time 

• Total storage 

To get this summary, you extract a comma-separated value (CSV) file from a CICS PA summary HDB, 
and then use an Excel macro to create graphical charts of the data. 

This is one of the charts created by the supplied Excel macro: 

 

Figure 5. Transaction response time chart 

To see a complete set of charts created by the macro, open the supplied file "CICS charts - scenario 2 
- example.xlsx". 
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Creating the charts 

To create these charts: 

1. Define a summary HDB template (option 5.1 Historical Database > Template, enter NEW) with 
the following two key fields, in this order: 

a. START 
b. TRAN 

Then include at least the following non-key fields in the template, in this order: 

• Miscellaneous: 

          TASKTCNT 

• Task Storage: 

          SC24CHWM 
          SC24UHWM 
          SC31CHWM 
          SC31UHWM 

• Program Storage: 

          PC24CHWM 
          PC24RHWM 
          PC24SHWM 
          PC31CHWM 
          PC31RHWM 
          PC31SHWM 

• Time: 

          DISPATCH 
          SUSPEND 
          RESPONSE 
          CPU 
          DISPWAIT 

• File access: 

          FCTOTAL 

Set the time interval to one day (24:00:00). 

2. Define an HDB using this template. 
3. Load the HDB with SMF data from the affected CICS systems. 
4. Extract a CSV data set from the HDB: 

• Set the time interval processing option to one day (24:00:00). 

This combination of summary time interval and extract report interval ensures that the CSV 
data set contains exactly one row per CICS transaction, with summarized performance data 
for the extracted 24-hour interval. This is a deliberately simplistic choice to simplify the 
coding of the supplied Excel macro. 
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• Specify a comma (,) as the delimiter character, not the CICS PA default semicolon (;). 
• Include field labels. 
• Do not select the (z/OS host-specific) float format for numeric fields. 

5. Transfer the CSV data set to a PC file with extension .csv. 

See “Appendix A Transferring CSV files interactively” for one way to transfer the data set. 

6. Open the supplied file "CICS charts - macros.xlsm" in Excel, and run the macro 
SamplePerformanceChartSet. 

 
You can either select it on the Home tab, CP12 group, or press F8 and run it from the list of 
available macros. 

The macro displays a File Open dialog box prompting you for the CSV file, and then prompts you 
for a list of transaction identifiers to exclude from the charts (separate multiple identifiers with 
spaces). 

The macro uses the details that you enter to create the charts, and then displays a Save As dialog 
box, prompting you to save the charts as an Excel workbook or a Web page. If you do not want 
to save the charts, click Cancel on the Save As dialog box. 

7. When prompted for a CSV file, use the supplied sample file "CICS charts - scenario 2 - sample 
performance data.csv". 

By running this once successfully with the sample CSV file, you will see the charts that are 
supposed to be produced. You can then run the macro again using your own CSV file. 
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The following figure illustrates these steps: 

 

Figure 6. Using a Microsoft Excel macro to create graphical charts from a CSV file 

Understanding the Excel macro 

To view the macro source in Excel: 

1. Open the file "CICS charts - macros.xlsm" (if it is not already open). 
2. Click Tools > Macro > Macros... > Visual Basic Editor 
3. In the Project window, expand the Modules folder, and then double-click the CSVCode module. 

The macro source appears in the main window area. 

The first procedure, SamplePerformanceChartSet, is an example of a call to the procedure 
that does the actual work, PerformanceChartSet. The PerformanceChartSet procedure: 

1. Displays the File Open dialog box for a CSV file. 
2. Opens the selected CSV file. 
3. Prompts for the list of transaction identifiers to exclude. 
4. Appends new columns to the CSV data, using formulas to calculate values from existing columns: 

• The "Storage Total" column aggregates the storage-related columns. This provides the data 
for the "Storage" chart. 

Excel

Macro

CICS
Performance
Analyzer

Extract

z/OS

Transfer

Windows

.csv file

SMF data set

Historical 
database 
(HDB)

CSV data set

Load
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• The "Wait Total" column aggregates the suspend time and dispatch time columns. This 
provides the data for the "Wait time" chart. 

5. Calls the CreateChart procedure (defined in the ChartCode module) to create the charts. 
6. Calls the SaveOutput procedure (defined in the CommonCode module) to save the charts 

either as an Excel workbook or as a Web page. 
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Scenario 3. Tuning LSR buffer pools 
This scenario is only applicable to customers who use DB2. In this scenario, you create a daily report 
for a specified CICS system (APPLID) running on a specified MVS system (MVSID). 

Suppose that you are a CICS administrator, and you want to ensure that your local shared resource 
(LSR) buffer pools are providing optimal performance to CICS applications. In particular, you want to 
maximize the number of "lookasides" (file read requests satisfied by the buffers), and minimize 
costly direct "execute channel program" (EXCP) file requests. 

For each buffer pool, you want a report of buffer activity including a "lookaside ratio": the number of 
lookasides as a percentage of all read requests. For optimal performance, you want this ratio to be 
as close to 100% as possible (some direct file access is required to populate the buffers, so this ratio 
can never actually reach 100%). You also want to see details for each file, to identify which files are 
responsible for poor lookaside ratios. Files with high EXCP figures may require reorganization. 

 

Figure 7. Tuning LSR buffer pools: example report 
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Overview 

CICS statistics provide the raw data for this report. To create this report, we will: 

1. Use CICS PA to: 

a. Define and load a statistics HDB with the required LSR pool and file statistics (from an 
SMF data set). 

b. Export the HDB to DB2 tables. 

2. Use DB2 Query Management Facility for z/OS (QMF) to: 

a. Define queries (SQL SELECT statements) to return the data that we want from the DB2 
tables, and also calculate derived statistics (such as the lookaside ratio). 

b. Define forms to enhance the layout of the statistics returned by the queries. 
c. Define a procedure to run the queries with their forms, and print the results. 

For this report, we will define: four queries, each with their own form, and a single procedure to 
run the queries. This procedure will print the formatted query results to a single file, giving the 
appearance of a single report. 

3. Write JCL to run the QMF procedure as a batch job. 

 

Figure 8. Using QMF to create a report from CICS statistics 
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Detailed procedure 

Here is the detailed procedure for creating the report (this assumes that you have an SMF data set 
that contains LSR pool and file statistics). The QMF objects that you use in these steps are described 
under “QMF Objects” after this procedure. 

1. In CICS PA Define and load a statistics HDB. 

When defining the HDB, specify that you want the following statistics to be collected (these 
appear under the "Files and Databases" category): 

• Files 
• VSAM LSR Pools 
• VSAM LSR Pool Buffers 
• VSAM LSR Pool Files 

2. In CICS PA, export the statistics collected in the HDB to DB2 tables. 

Select only the statistics (listed above) that have been collected in the HDB. 

This exports data to four DB2 tables, one for each type of statistic selected: 

• database.CPA_HST067A for Files 
• database.CPA_HST039A for VSAM LSR Pools 
• database.CPA_HST039B for VSAM LSR Pool Buffers 
• database.CPA_HST040A for VSAM LSR Pool Files 

where database is the database name (in DB2 terms, the "authorization ID") that you specified 
in CICS PA. 

Next, you will define some QMF objects. Rather than defining these objects in QMF yourself, 
you can save some typing by using the supplied .qmf files. These contain QMF objects that have 
been exported from QMF to data sets on z/OS, and then transferred as text files to PC. To use 
these files, you must transfer them to z/OS, and then import them into QMF. A Windows script 
and a QMF procedure have been supplied to help automate these steps. 

3. Define the QMF queries, forms, and procedure: 

a. In Windows Explorer, open the folder containing the following supplied files: 

 CPA_LSR_BUFFERS_F.qmf 
 CPA_LSR_BUFFERS_Q.qmf 
 CPA_LSR_FILES_F.qmf 
 CPA_LSR_FILES_Q.qmf 
 CPA_LSR_HEADER_F.qmf 
 CPA_LSR_HEADER_Q.qmf 
 CPA_LSR_ID_Q.qmf 
 CPA_LSR_P.qmf 
 CPA_LSR_POOLS_F.qmf 
 CPA_LSR_POOLS_Q.qmf 
 CPA_LSR_PORT_P.qmf 

b. Double-click the Window script file “Transfer QMF objects - put onto host.wsf”. 

This transfers all the .qmf files (that are in the same folder as the script) onto the host. 
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This script strips the .qmf extension from the file names, replaces underscores with 
periods, prepends the high-level qualifier that you specify, and then uses the FTP login 
details that you specify to transfer the files to z/OS. 

For example, if you specify the high-level qualifier MYID.QMF, then the script transfers 
the PC file CPA_LSR_PORT_P.qmf to the z/OS data set ’MYID.QMF.CPA.LSR.PORT.P’. 

c. Confirm that the expected data sets have been created on z/OS. 

One of the supplied QMF objects is a procedure that automates the importing of other 
QMF objects. In the following steps, we are going to manually import this procedure 
into QMF, and then run the procedure to import the other QMF objects. 

d. Start QMF. 
e. On the QMF command line, enter: 

IMPORT PROC CPA_LSR_PORT_P FROM 'hlq.CPA.LSR.PORT.P' 

where hlq is the high-level qualifier that you specified. 

Note: QMF object names are case-sensitive: the supplied objects names are uppercase. 

f. Display the procedure: 

DISPLAY PROC CPA_LSR_PORT_P 

g. Run the procedure (press F2). 

For each supplied CPA_LSR_*.qmf file, there should now be a matching CPA_LSR_* 
object in QMF. 

h. To check this, enter LIST ALL on the QMF command line. 

4. Create a member containing the following JCL, replacing the data set high-level qualifiers to 
match your system, and replacing the variables in the QMF OPTIONS sections similarly. 

This JCL is also supplied with CP12 in the file batch-QMF-JCL.txt. 
------------------------------------------------------------------------ 
//BATCHQMF  JOB  CLASS=X,MSGCLASS=X,NOTIFY=&SYSUID 
//********************************************************** 
//          EXPORT SYMLIST=*          ,SYMBOLS=(JCLONLY) 
//********************************************************** 
//* HIGH-LEVEL QUALIFIERS: 
//  SET  DB2=db2-hlq 
//  SET  QMF= qmf-hlq 
//  SET ISPF= ispf-hlq 
//  SET GDDM= gddm-hlq 
//********************************************************** 
//* QMF OPTIONS 
//********************************************************** 
//  SET IWANT='authid.CPA_LSR_P' 
//  SET DB2ID=db2-authid 
//  SET SSID=db2 ssid 
//  SET  APPL=applid 
//  SET   MVS=mvsid 
//********************************************************** 
//* QMF STEP 
//********************************************************** 
//QMFSTEP   EXEC PGM=IKJEFT01, 
//          TIME=1440, 
//          DYNAMNBR=30, 
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//          REGION=4M 
//********************************************************** 
//* PROGRAM LOAD LIBRARIES 
//********************************************************** 
//STEPLIB   DD   DSN=&ISPF..SISPPENU,DISP=SHR 
//          DD   DSN=&QMF..SDSQLOAD,DISP=SHR 
//          DD   DSN=&DB2..SDSNEXIT,DISP=SHR 
//          DD   DSN=&DB2..SDSNLOAD,DISP=SHR 
//          DD   DSN=&GDDM..SADMMOD,DISP=SHR 
//********************************************************** 
//* SYSEXEC USED BY QMF 
//********************************************************** 
//SYSEXEC   DD   DSN=&QMF..SDSQEXCE,DISP=SHR 
//********************************************************** 
//* DATASETS USED BY ISPF 
//********************************************************** 
//ISPPLIB   DD   DSN=&ISPF..SISPPENU,DISP=SHR 
//          DD   DSN=&QMF..SDSQPLBE,DISP=SHR 
//ISPMLIB   DD   DSN=&ISPF..SISPMENU,DISP=SHR 
//          DD   DSN=&QMF..SDSQMLBE,DISP=SHR 
//ISPSLIB   DD   DSN=&ISPF..SISPSENU,DISP=SHR 
//          DD   DSN=&QMF..SDSQSLBE,DISP=SHR 
//ISPTLIB   DD   DSN=&ISPF..SISPTENU,DISP=SHR 
//ISPPROF   DD   UNIT=SYSDA,SPACE=(TRK,(9,1,4)), 
//          DCB=(LRECL=80,BLKSIZE=3120,RECFM=FB) 
//SYSUDUMP  DD   SYSOUT=A 
//********************************************************** 
//* QMF/GDDM MAPS 
//********************************************************** 
//ADMGGMAP  DD   DSN=&QMF..SDSQMAPE,DISP=SHR 
//********************************************************** 
//* DATASETS USED BY QMF 
//********************************************************** 
//DSQPNLE   DD   DSN=&QMF..DSQPNLE,DISP=SHR 
//DSQPRINT  DD   SYSOUT=A,DCB=(RECFM=FBA,LRECL=133,BLKSIZE=1330) 
//DSQDEBUG  DD   SYSOUT=A,DCB=(RECFM=FBA,LRECL=121,BLKSIZE=1210) 
//DSQUDUMP  DD   SYSOUT=A,DCB=(RECFM=VBA,LRECL=125,BLKSIZE=1632) 
//SYSTSPRT  DD   SYSOUT=A 
//SYSTSIN   DD   *,SYMBOLS=(JCLONLY) 
ISPSTART PGM(DSQQMFE) + 
PARM(M=B,+ 
S=&SSID,+ 
I=&IWANT.(+ 
&&DATABASE=&DB2ID.,+ 
&&APPLID='&APPL.',+ 
&&MVSID='&MVS.'+ 
)) + 
NEWAPPL(DSQE) 
/* 
------------------------------------------------------------------------ 

Figure 9. Tuning LSR buffers: JCL to call a QMF procedure 
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Variable Description 

authid   Authorization ID that you used to create the QMF procedure, queries, and forms 
(unless you explicitly defined this in QMF, this defaults to your TSO user ID). 

db2-authid In DB2 terms, the "authorization ID" that you specified in CICS PA when you 
exported the HDB to DB2. 

db2-ssid The 4-character DB2 subsystem ID. 

applid CICS application that you want to report on. 

mvsid MVS ID of the system running the CICS application that you want to report on. 

Table 4. Variables for QMF JCL 
Notice that there are single quotes around the applid and mvsid variable values, but not the 
database variable value. This is because of the different ways in which these values are 
substituted in the SQL queries. 

5. Submit the JCL. The job outputs the report to the DSQPRINT ddname. 

LSR buffer pool statistics                                                       
--------------------------                                                       
                                                                                 
Generated 2017-04-19 14.45.50                                                    
                                                                                 
     CICS       MVS    Start       Start     Stop        Stop                    
  application  system  date        time      date        time                    
  -----------  ------  ----------  --------  ----------  --------                
  IYCVU001     MV2B    2017-04-14  11.35.45  2017-04-14  11.37.21                
                                                                                 
Pools:                                                                           
                                                                                 
              Max                       Max         Total         Peak           
  LSR         key                     active        string       string          
  pool       length      Strings      strings       waits        waits           
  ----  -----------  -----------  -----------  -----------  -----------          
     3           22           12            1            0            0          
                                                                                 
Buffers:                                                                         
                                                                                 
  LSR                  Buffer     Number      Lookaside       Buffer       Buffe 
  pool  Type            size    of buffers      hits          reads        write 
  ----  --------  -----------  -----------  -----------  -----------  ---------- 
     3  BOTH              512            0            0            0             
     3  BOTH             1024            0            0            0             
     3  BOTH             2048            4          537           14             
     3  BOTH             4096            0            0            0             
     3  BOTH             8192            4          184          124             
     3  BOTH            12288            0            0            0             
     3  BOTH            16384            0            0            0             
     3  BOTH            20480            0            0            0             
     3  BOTH            24576            0            0            0             
     3  BOTH            28672            0            0            0             
     3  BOTH            32768            0            0            0             
                                                                                 
Files:                                                                           
                                                                                 

 

QMF Objects 
Queries 

CPA_LSR_ID_Q 

A "pre-report" query. This lists the application ID and MVS ID combinations in the DB2 tables. 
This is not used in the report itself, but it is useful because the queries used in the report require 
you to specify values for an application ID and an MVS ID: 
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------------------------------------------------------------------------ 
SELECT MVSID, APPLID 
  FROM CPA_HST040A 
  GROUP BY MVSID, APPLID 
------------------------------------------------------------------------ 

Figure 10. Tuning LSR buffers: pre-report query 
The report consists of formatted output from the following queries: 

CPA_LSR_HEADER_Q 

Report header: 
------------------------------------------------------------------------ 
SELECT APPLID, 
       MVSID, 
       DATE(START_DATE) AS START_DATE, 
       TIME(START_DATE) AS START_TIME, 
       DATE(STOP_DATE)  AS STOP_DATE, 
       TIME(STOP_DATE)  AS STOP_TIME 
FROM   (SELECT APPLID, 
               MVSID, 
               MIN(TIMESTAMP(START_DATE, START_TIME)) AS START_DATE, 
               MAX(TIMESTAMP(START_DATE, START_TIME)) AS STOP_DATE 
        FROM   &DATABASE.CPA_HST039A 
        WHERE  APPLID=&APPLID AND 
               MVSID=&MVSID 
        GROUP BY 
               APPLID, 
               MVSID 
        ) AS DUMMY; 
------------------------------------------------------------------------ 

Figure 11. Tuning LSR buffers: report header query 
CPA_LSR_POOLS_Q 

Buffer pool statistics: 
------------------------------------------------------------------------ 
SELECT 
  LSR_POOL_NUMBER, 
  MAX(MAX_KEY_LENGTH) AS MMAX_KEY_LENGTH, 
  SUM(STRINGS) AS SUM_STRINGS, 
  MAX(STRINGS_ACTIVE_PK) AS MAX_ACTIVE_PK, 
  SUM(STRING_WAITS_TOTAL) AS SUM_WAITS_TOTAL, 
  MAX(STRING_WAITS_PEAK) AS MAX_WAITS_PK 
FROM 
  &DATABASE.CPA_HST039A 
WHERE 
  APPLID = &APPLID AND 
  MVSID = &MVSID 
GROUP BY 
  LSR_POOL_NUMBER; 
------------------------------------------------------------------------ 

Figure 12. Tuning LSR buffers: pool statistics query 
CPA_LSR_BUFFERS_Q 

Buffer statistics: 
------------------------------------------------------------------------ 
SELECT 
  LSR_POOL_NUMBER, 
  BUFFER_TYPE, 
  BUFFER_SIZE, 
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  BUFFERS, 
  SUM(LOOKASIDES) 
    AS SUM_LOOKASIDES, 
  SUM(BUFFER_READS) 
    AS SUM_BUFFER_READS, 
  SUM(USER_WRITES) 
    AS SUM_USER_WRITES, 
  SUM(NONUSER_WRITES) 
    AS SUM_NONUSER_WRITES, 
  CASE 
    WHEN -- AVOID DIVISION BY ZERO; SET RESULT TO ZERO 
      SUM(BUFFER_READS) + SUM(LOOKASIDES) = 0 THEN 0.0 
    ELSE -- DERIVE PERCENTAGE OF LOOKASIDES 
          DECIMAL(100 * 
                  FLOAT(SUM(LOOKASIDES)) / 
                  (SUM(LOOKASIDES) + SUM(BUFFER_READS)), 
                  5,1) -- FLOAT FORCES NON-INTEGER DIVISION 
  END 
    AS LOOKASIDE_RATIO 
FROM 
  &DATABASE.CPA_HST039B 
WHERE 
  APPLID = &APPLID AND 
  MVSID = &MVSID 
GROUP BY 
  LSR_POOL_NUMBER, 
  BUFFER_TYPE, 
  BUFFER_SIZE, 
  BUFFERS; 
------------------------------------------------------------------------ 

Figure 13. Tuning LSR buffers: buffer statistics query 
CPA_LSR_FILES_Q 

File statistics: 
------------------------------------------------------------------------ 
SELECT 
  FILE_NAME, 
  LSR_POOL_NUMBER, 
  MAX_D_BUF_SIZE, 
  MAX_I_BUF_SIZE, 
  SUM_BUFFER_WAITS, 
  SUM_BUF_WAITS_PEAK, 
  SUM_STR_WAITS_TOT, 
  SUM_STR_WAITS_PEAK, 
  SUM_EXCP_REQ_DATA, 
  SUM_EXCP_REQ_INDX, 
  TOTAL_REQ, 
  INT(100 * FLOAT(SUM_GET_REQ) / NULLIF(TOTAL_REQ, 0))    AS PC_GET, 
  INT(100 * FLOAT(SUM_GETUPD_REQ) / NULLIF(TOTAL_REQ, 0)) AS PC_GETUPD, 
  INT(100 * FLOAT(SUM_BROWSE_REQ) / NULLIF(TOTAL_REQ, 0)) AS PC_BROWSE, 
  INT(100 * FLOAT(SUM_ADD_REQ) / NULLIF(TOTAL_REQ, 0))    AS PC_ADD, 
  INT(100 * FLOAT(SUM_UPDATE_REQ) / NULLIF(TOTAL_REQ, 0)) AS PC_UPDATE, 
  INT(100 * FLOAT(SUM_DELETE_REQ) / NULLIF(TOTAL_REQ, 0)) AS PC_GET, 
  DATA_SET_NAME 
 
 
FROM (SELECT 
        &DATABASE.CPA_HST040A.FILE_NAME AS FILE_NAME, 
        &DATABASE.CPA_HST040A.LSR_POOL_NUMBER AS LSR_POOL_NUMBER, 
        MAX(DATA_BUFFER_SIZE)   AS MAX_D_BUF_SIZE, 
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        MAX(INDEX_BUFFER_SIZE)  AS MAX_I_BUF_SIZE, 
        SUM(BUFFER_WAITS)       AS SUM_BUFFER_WAITS, 
        SUM(BUFFER_WAITS_PEAK)  AS SUM_BUF_WAITS_PEAK, 
        SUM(STRING_WAITS_TOTAL) AS SUM_STR_WAITS_TOT, 
        SUM(STRING_WAITS_PEAK)  AS SUM_STR_WAITS_PEAK, 
        SUM(VSAM_EXCP_REQ_DATA) AS SUM_EXCP_REQ_DATA, 
        SUM(VSAM_EXCP_REQ_INDX) AS SUM_EXCP_REQ_INDX, 
        SUM(GET_REQUESTS)       AS SUM_GET_REQ, 
        SUM(GET_UPDATE_REQ)     AS SUM_GETUPD_REQ, 
        SUM(BROWSE_REQUESTS)    AS SUM_BROWSE_REQ, 
        SUM(ADD_REQUESTS)       AS SUM_ADD_REQ, 
        SUM(UPDATE_REQUESTS)    AS SUM_UPDATE_REQ, 
        SUM(DELETE_REQUESTS)    AS SUM_DELETE_REQ, 
        SUM(GET_REQUESTS) + 
        SUM(GET_UPDATE_REQ) + 
        SUM(BROWSE_REQUESTS) + 
        SUM(ADD_REQUESTS) + 
        SUM(UPDATE_REQUESTS) + 
        SUM(DELETE_REQUESTS)    AS TOTAL_REQ, 
        DATA_SET_NAME 
      FROM 
        &DATABASE.CPA_HST040A INNER JOIN &DATABASE.CPA_HST067A 
      ON 
        &DATABASE.CPA_HST040A.FILE_NAME = &DATABASE.CPA_HST067A.FILE_NAME 
      WHERE 
        &DATABASE.CPA_HST040A.APPLID = &APPLID AND 
        &DATABASE.CPA_HST040A.MVSID = &MVSID 
      GROUP BY 
        &DATABASE.CPA_HST040A.FILE_NAME, 
        &DATABASE.CPA_HST040A.LSR_POOL_NUMBER, 
        DATA_SET_NAME 
     ) AS DUMMY; 
------------------------------------------------------------------------ 

Figure 14. Tuning LSR buffers: file statistics query 
(Notice the use of the subquery to define the column TOTAL_REQ for use in the main query.) 

Forms 
One form for each of the four queries used in the report.  The supplied forms have the same 
names as their matching queries, but with an _F suffix instead of a _Q suffix. 

If you prefer to define these forms yourself, rather than importing the supplied objects, then 
refer to the "*_F.qmf" supplied files for formatting details. Save the forms using similar names as 
their matching queries: replace the _Q suffix with _F. 

Procedure 
One procedure, CPA_LSR_P, to concatenate the formatted query results into a single report: 

------------------------------------------------------------------------ 
SET PROFILE (CONFIRM=NO 
SET GLOBAL (DATABASE=&DATABASE 
SET GLOBAL (APPLID=&APPLID 
SET GLOBAL (MVSID=&MVSID 
-- Header 
RUN QUERY CPA_LSR_HEADER_Q ( 
+&&DATABASE=&DATABASE, 
+&&APPLID=&APPLID, 
+&&MVSID=&MVSID, 
+FORM=CPA_LSR_HEADER_F 
PRINT REPORT (PRINTER='',WIDTH=165, 
+LENGTH=CONT,DATETIME=NO,PAGENO=NO 
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-- Pools 
RUN QUERY CPA_LSR_POOLS_Q ( 
+&&DATABASE=&DATABASE, 
+&&APPLID=&APPLID, 
+&&MVSID=&MVSID, 
+FORM=CPA_LSR_POOLS_F 
PRINT REPORT (PRINTER='',WIDTH=165, 
+LENGTH=CONT,DATETIME=NO,PAGENO=NO 
-- Buffers 
RUN QUERY CPA_LSR_BUFFERS_Q ( 
+&&DATABASE=&DATABASE, 
+&&APPLID=&APPLID, 
+&&MVSID=&MVSID, 
+FORM=CPA_LSR_BUFFERS_F 
PRINT REPORT (PRINTER='',WIDTH=165, 
+LENGTH=CONT,DATETIME=NO,PAGENO=NO 
-- Files 
RUN QUERY CPA_LSR_FILES_Q ( 
+&&DATABASE=&DATABASE, 
+&&APPLID=&APPLID, 
+&&MVSID=&MVSID, 
+FORM=CPA_LSR_FILES_F 
PRINT REPORT (PRINTER='',WIDTH=165, 
+LENGTH=CONT,DATETIME=NO,PAGENO=NO 
 
------------------------------------------------------------------------ 

Figure 15. Tuning LSR buffers: report procedure 
If you use your own naming convention for QMF objects, then replace the query and form 
names shown in the procedure listing above. 

Notice how the commands that set or pass variable values refer to variable names (indicated by 
an ampersand prefix)  instead of actual values. This is because we will call the procedure from 
batch JCL that sets the variable values. 

This is an example of a linear QMF procedure: it contains no REXX logic. If you begin a QMF 
procedure with a REXX comment line, you can use REXX features such as subroutines to 
eliminate repetitive code. This is shown in the supplied procedure for importing and exporting 
QMF objects (CPA_LSR_PORT_P), in Appendix B, "Distributing QMF for z/OS objects via PC". 

 
 

QMF tips 

• To define a new query in QMF: 

1. On the QMF command line, enter RESET QUERY. 

2. Begin typing the query on the QMF panel, or enter EDIT to use the ISPF editor. If you 
choose to use the ISPF editor, then exit the editor when you have finished typing 
(you cannot enter QMF commands on the ISPF editor command line). 

3. To test the query, enter RUN. 

4. On the QMF command line, enter SAVE AS name (up to 16 characters: we 
recommend that you use uppercase only). 

• To display an existing QMF object (such as a query), enter DISPLAY objectname. 

• Use a consistent naming convention for QMF objects (such as standard suffixes for object 
types: _Q for query, _F for form, _P for procedure). 

• To begin defining a new procedure in QMF, enter RESET PROC. 



 

© Copyright IBM Corp. 2005, 2017; Copyright Fundi Software 2005, 2017 51 

Scenario 4. Comparing current and previous CICS performance 
To compare the performance of your CICS systems before and after migrating from one CICS TS 
release to another, you can use the CICS PA Transaction Profiling report. The Transaction Profiling 
report can show differences between the before and after data as a "delta" (after minus before 
values) or as a percentage change. 

To supplement the CICS PA Transaction Profiling report, you can use the CICS PA Compare Before-
After Excel add-in supplied with this SupportPac to provide a graphical representation of the before 
and after data. To use this add-in, you need two CSV files from CICS PA: one containing a summary of 
performance data for a time period before migration, the other containing a similar summary of 
performance data for a time period after migration. The add-in creates an Excel workbook that 
shows differences between the two CSV files, with increases highlighted in red and decreases 
highlighted in green: the greater the percentage difference, the deeper the intensity of color. The 
following figure illustrates this approach to comparing before and after performance data: 

 

Figure 16. CICS PA Compare Before-After Excel add-in: overview 
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Here is a sample comparison created by the add-in: 

 

Figure 17. CICS PA Compare Before-After Excel add-in: sample comparison 

In this sample, we can see that L8 CPU times have increased, possibly indicating issues related to 
DB2 or threadsafe processing. (Note that this sample was generated using data from systems in a 
development environment, and does not reflect typical before/after migration differences in a 
production environment.) 

A sample workbook created by this add-in is supplied with this SupportPac in the file "CICS PA 
Compare Before-After - sample.xlsx". 

When you run the CICS PA Compare Before-After Excel add-in, you specify the locations of the 
before and after CSV files, and also a minimum and a maximum percentage difference for 
highlighting. Percentage differences less than the minimum value are not highlighted. Percentage 
differences up to the maximum value are highlighted in colors of increasing intensity. The deepest 
intensity color indicates percentage differences greater than the maximum value. The following 
figure shows the "Key to colors" sheet in a workbook created by this add-in, illustrating how these 
minimum and maximum values determine the highlighting: 

Tran #Tasks Response Time Avg Dispatch Time Avg User CPU Time Avg Suspend Time Avg QR CPU Time Avg KY8 CPU Time Avg L8 CPU Time Avg

A101 -15 0.010186 0.011222 0.002082 -0.00291 -4.00E-05 7.00E-05 0.001558

A102 8

7

6

-0.01501 0.003454 0.001642 -0.01973 -1.00E-05

0

-3.90E-04

-1.40E-04

0.00105

0.001504

8.76E-04

0.001394

A103 6.48E-03 6.13E-03 0.002096 -0.00138

A104 -8.05E-03 8.31E-03 0.00133 -0.01808 -1.90E-04 -9.60E-04

A105 0 6.51E-03 0.009418 0.001992 -0.0044 0 -1.00E-05

A106 24 8.11E-03 0.008484 0.0029 -0.00186 -1.00E-05

-1.00E-05

6.50E-04

5.90E-04

0.002354

A109 2 0.016988 0.014272 0.003016 0.00112 0.002454

A110 0 -9.30E-03 0.004936 0.001496 -0.01728

-0.00293

-0.00015 -0.00037

-8.00E-05 -0.00027

0.00101

0.00111

0.000792

A115 -6 -4.48E-03 -2.05E-03 0.001734

A116 0 0.013184 0.012018 0.001216 2.50E-04 -1.00E-05 -2.00E-05

A117 -1 0.001882 0.00163 0.00139 -7.00E-04 1.60E-04 7.00E-05 0.00077

A118

A124 -1 0.001362 0.000976 0.0007 0.00018 -7.00E-05 -0.00003 0.000446
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Figure 18. CICS PA Compare Before-After Excel add-in: sample comparison: how minimum and 
maximum percentage differences affect color highlighting 

Note: This add-in was initially presented as a macro in the IBM redbook Migration Considerations 
for CICS Using CICS CM, PA, and IA SG24-7294-00. 

Distributing Excel macros in add-ins versus workbooks 

The macros for this scenario are provided in an Excel add-in (.xlam) file. Add-in files offer several 
benefits over workbook (.xlsx) files as a way of distributing macros to other users: 

• Users can run macros in add-ins without lowering their macro security level. 

• If your macros add interactive features to a workbook, then rather than embedding the macros 
in each workbook, you can run them from an add-in. As you introduce new features to your 
macros, users can simply install an updated add-in, rather updating or recreating each 
workbook. 

To save a workbook as an add-in, click File > Save As... > Save as type: Excel Add-In (*.xlam). 

Installing the CICS PA Compare Before-After Excel add-in 

The add-in consists of a single file, “CICS PA Compare Before-After.xlam”. If you know how to install 
Excel add-ins, skip the detailed procedure below and just install the add-in; it has no special 
installation requirements. 

To install the CICS PA Compare Before-After Excel add-in: 

1. Close any open Excel windows. 
2. Copy the add-in file “CICS PA Compare Before-After.xlam” to your Excel add-ins folder. 

Typical path of add-ins folder for Excel 2010 and Excel 2016 users: 

C:\Users\<username>\AppData\Roaming\Microsoft\AddIns 

Maximum percentage difference
specified in this example

Less than 2.5% difference
Minimum percentage difference
specified in this example

Value decreased by up to 100%

Value increased by more than 100%

Value increased by up to 100%

No equivalent data to compare
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3. Start Excel. 
4. For Excel 2010 or Excel 2016 users: select File > Options > Add-ins > In the Manage list in the 

lower left select Excel Add-ins > click Go. 

The Add-In dialog box appears, showing the list of available add-ins. A selected checkbox next to 
an add-in indicates that the add-in is installed. An unselected checkbox indicates that an add-in 
is available for installation, but is not currently installed. 

5. Select the checkbox next to the CICS PA Compare Before-After Excel add-in (if this add-in does 
not appear in the list of available add-ins, click the Browse button to locate it). 

6. Click OK to close the Add-Ins dialog box. 

An option for the macro appears on the Home tab, CP12 group. 

 

Using the CICS PA Compare Before-After Excel add-in 

To use the add-in: 

1. Use CICS PA to create two performance data extracts. 

If you want to try the add-in before using your own data, use the sample files "CICS PA Compare 
Before-After - before.csv" and "CICS PA Compare Before-After - after.csv" supplied with this 
SupportPac. 

To ensure that the extracts you create are compatible with the add-in: 

• Specify a comma (,) as the delimiter character, not the CICS PA default semicolon (;). 
• Include field labels. 
• Do not select the (z/OS host-specific) float format for numeric fields. 
• Transfer the CSV file to your PC as an ASCII text file with file extension .csv. 
• Use a summary report form that has only one key field, such as transaction ID (TRAN). For 

example, use the sample summary report form CPU5SUM supplied with CICS PA. 

If you cannot see the AppData folder 

Windows classifies your AppData folder as a “hidden” folder. If you cannot see this folder in Windows 
Explorer, you need to adjust your View options: in Windows Explorer, click File > Options... > View > 
Hidden files and folders > Show hidden files, folders and drives. 

About the Excel add-ins folders 

Storing add-in files in your Excel add-ins folder has two benefits: 

• In the Excel security model, your Excel add-ins folder is known as a “trusted location”. 

• To install an Excel add-in, you select it from a list of available add-ins displayed by the Excel Add-
Ins dialog box (we will do this in a later step). If the add-in is already in your Excel add-ins folder, 
the add-in automatically appears in this list; otherwise, you must click a Browse button on the 
dialog box to locate the add-in. 
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Note: If you are extracting from an HDB, you cannot use any field with the MAX function 
because MAX values are not stored in the HDB. In that situation, change MAX to TOT or 
remove the MAX field from the form before you perform the extract. 

• The two extracts should use the same field for the first column, and some of the same fields 
for other columns (so that there is some data to compare!), but the extracts do not need to 
have the same number of columns or rows. 

The add-in compares cells that have the same row and column headings, and marks with 
diagonal hatching any cells that appear in one extract but not the other. Except for the first 
column heading, the column and row headings do not need to be in the same order in the 
two extracts: the comparison is based on matching column and row headings, not on ordinal 
cell positions. For example, although the “before" and "after" extracts must use the same 
field, such as transaction ID, for their first column (the row headings), the “after" extract 
does not need to contain all the transaction IDs that appear in the "before" extract. 

2. Start Excel, and then click Compare before-after CSVs in the CP12 group on the Home tab. 
3. Select the two CSV files, specify minimum and maximum percentage differences, and then click 

Compare. 

The add-in creates a new workbook like the one shown at the start of this scenario. You can save this 
workbook and make it available to users who do not have the add-in installed; the add-in is only 
required for creating the workbook. 

After using this add-in to highlight differences in before and after data, you can use the formatted 
reports provided by CICS PA to identify the issues that caused those differences. 

 

Other uses for the CICS PA Compare Before-After Excel add-in 

While this add-in is useful for comparing performance differences before and after migration to a new 
CICS TS release, the before and after CSV files can contain data for any two time periods. For example, you 
could create a CSV file summarizing CICS performance for the last year, and compare that with a CSV file 
summarizing CICS performance for the last week. Or you could create a “benchmark” CSV file containing 
values required to meet a service-level agreement, and use that as a “before” CSV file to compare with 
current performance. In fact, you can use this add-in to compare any two CSV files containing numerical 
data with row and column headings, where at least some of the headings in the two files match. For 
example, you could use this add-in to compare CSV files generated by IBM IMS™ Performance Analyzer for 
z/OS (IMS PA). 
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Scenario 5. Threadsafe performance issues: TCB CPU usage and 
change modes 
To tune the performance of threadsafe CICS applications, or to review which of your CICS 
applications are candidates for being defined as threadsafe, it is useful to know how many times 
your CICS transactions switch between task control block (TCB) modes, and how much CPU time 
they spend in each TCB mode. 

In this scenario, we create charts of this TCB mode data, first using a CICS PA performance summary 
data extract to get an overview, and then, for more a detailed view, a performance list data extract. 
For more information on analyzing the data in these charts, see the IBM redbook Threadsafe 
Considerations for CICS, SG24-6351-04. 

To chart the summary data, we use the CICS PA TCB Mode Analysis Excel add-in supplied with this 
SupportPac. This add-in requires an extract that you have created using the sample summary report 
form CPU5SEXT supplied with CICS PA. The report form contains the TCB mode-related fields that we 
are interested in, summarized by transaction ID. Here is an example summary chart generated by 
the add-in: 

 

Figure 19. CICS PA TCB Mode Analysis Excel add-in: summary chart 

You can click a bar in the summary chart to display a pie chart of average CPU time per TCB mode for 
that transaction ID: 

Red stripes indicate
that a value exceeds
the warning threshold
you specified for
average response time
or average TCB mode
switches

Click a bar to view
a pie chart of TCB
mode usage for
that transaction ID
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Figure 20. CICS PA TCB Mode Analysis Excel add-in: pie chart of average CPU time per TCB mode 
for a particular transaction ID 

High numbers of TCB mode switches indicate that the application code for a transaction might 
require tuning. 

Click anywhere on the pie chart to see a bar chart of maximum CPU time per TCB mode for that 
transaction. 

This pie chart displays the 
average CPU time that a 
transaction ID spends in 
each TCB mode

Click anywhere on the pie chart sheet 
to display a bar chart of maximum 
CPU times per TCB mode 
(if your data contains these values) or 
return to the summary chart
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Figure 21. CICS PA TCB Mode Analysis Excel add-in: bar chart of maximum CPU time per TCB mode 
for a particular transaction ID 

To chart the list data, we use the CICS PA Timeline Chart Excel add-in supplied with this SupportPac. 
This add-in, which you can use to chart any CICS PA performance or statistics extract that contains a 
timestamp field, charts timestamp values along the X-axis and data values along the Y-axis. To chart 
the list data for this scenario, we use an extract created using the sample list report form CPU5LEXT 
supplied with CICS PA. This extract contains TCB mode-related fields for individual transaction 
instances. Here is an example chart generated by the add-in: 

This bar chart is only displayed if your
data contains the required "Max" 
columns for each TCB mode

Click anywhere on the bar chart sheet
to return to the summary chart
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Figure 22. CICS PA Timeline Chart Excel add-in: charting a performance list data extract 

Creating TCB mode analysis charts 

To create the TCB mode analysis charts: 

1. Install the CICS PA TCB Mode Analysis Excel add-in. For details, see the equivalent procedure for 
"Installing the CICS PA Compare Before-After Excel add-in". 

2. Use CICS PA to create a performance summary data extract: 

• Base the extract on the sample summary report form CPU5SEXT. 
• Specify a comma (,) as the delimiter character, not the CICS PA default semicolon (;). 
• Include field labels. 
• Do not select the (z/OS host-specific) float format for numeric fields. 
• Transfer the CSV file to your PC as an ASCII text file with file extension .csv. 

See the sample file "CICS PA TCB Mode Analysis - sample.csv". 

Pan: scroll forwards or backwards 
along the timeline (X-axis)

Zoom: adjust the time interval 
displayed by the chart

Select the column you want to 
display on the Y-axis

The Timeline Chart toolbar only appears if you have installed the 
add-in, and you are viewing a workbook created by the add-in

This toolbar button performs the same action as the 
Timeline chart - CSV button in the CP12 group of the 
Home tab

Click a data point to create a 
worksheet of that data row 
"transposed" 90 degrees, so 
that column headings appear 
as row headings
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3. In Excel, select the CPU time per TCB mode option in the CP12 group on the Home tab. 

 
4. Select the CSV file. 
5. Specify warning threshold values for average response time and TCB mode switches (or leave 

the default values unchanged), and then click Create charts. 

 
6. When prompted, save the produced spreadsheet as an Excel (.xlsx) file. 

Note: In CICS TS 4.1 and 4.2, processor time can be recorded to the J8 or J9 TCB, but the fields for 
the J8 and J9 TCB modes were removed in CICS TS 5.1. The Excel macros for this scenario are 
designed with the assumption that the J8 and J9 fields are not present, and therefore any processor 
time recorded to the J8 or J9 TCBs is not shown in the charts for this scenario. 

Creating a timeline chart 

This timeline chart shows individual records and uses a list report form rather than a summary 
report form to provide the CSV extract. So that Excel has a manageable amount of data to work with, 
try to limit the number of records by choosing a narrow date/time range for Report Interval when 
you extract the data. 

To create a timeline chart for detailed analysis of TCB mode CPU times: 

1. Install the CICS PA Timeline Chart Excel add-in. For details, see the procedure for "Installing the 
CICS PA Compare Before-After Excel add-in". 

2. Use CICS PA to create a performance list data extract: 

• Base the extract on the sample list report form CPU5LEXT. 
• Specify a comma (,) as the delimiter character, not the CICS PA default semicolon (;). 
• Include field labels. 
• Do not select the (z/OS host-specific) float format for numeric fields. 
• Choose a narrow date/time range for Report Interval when you extract the data, to limit the 

number of records to be charted. 

A sample extract “CICS PA Timeline Chart - sample - cpu5lext.csv” is provided. 

In the following step, you can choose to either transfer the extract to your PC (using whatever 
transfer method you normally use), or have the add-in transfer the extract for you (and, 
optionally, submit the job on z/OS to create the extract). 

3. To transfer and then use the extract on your PC:  
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a. Transfer the extract to your PC as an ASCII text file with file extension .csv. 
b. In Excel, click Timeline chart – CSV on the toolbar. 

 
c. Browse to the extract CSV file. 

A spreadsheet containing the timeline chart is created. 

4. To have the add-in transfer the extract for you from z/OS: 

a. In Excel, click Timeline chart - zOS on the toolbar. 

 
b. Use the dialog box to specify the file transfer protocol (FTP) details: 

 
Figure 23. CICS PA Timeline Chart Excel add-in: creating timeline chart from a z/OS data set via FTP 

If you specify a JCL data set, the add-in does not 
check that the JCL outputs the same CSV data 
set that you specify here: you need to check this 
yourself
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c. If you want, click Change CSV file path to change the pathname of the CSV file to which 
the z/OS data set will be saved. 

d. Click Create chart. 

A spreadsheet containing the timeline chart is created. 

5. Click the Add-ins tab to see and use the Timeline toolbar. 

 
Usage notes for the CICS PA Timeline Chart Excel add-in:  

1. When charting a CSV file of performance data: 

• The CSV file must contain a timestamp field for the chart’s X-axis, such as the CICS PA 
performance field START (which appears in the CSV file with the column heading "Start 
Time"), and at least one numeric or clock field for charting on the Y-axis, such as RESPONSE 
("Response Time"). 

• This add-in bases the chart X-axis on the first field, or pair of fields, in the CSV file whose 
values look like a timestamp: 

 First, the add-in looks for a column that contains date and time values in the format 
yyyy-mm-dd hh:mm:ss (CICS PA DATETIM presentation format: ISO 8601 date format 
and time format, separated by a space), optionally followed by .thm (decimal fractions 
of a second). 

 Otherwise, the add-in looks for a column that contains date values in the format yyyy-
mm-dd (CICS PA DATEISO presentation format) immediately followed by a column that 
contains time values in the format hh:mm:ss.thm (TIMET) or hh:mm:ss (TIMES). 

To achieve this, you use a CICS PA report form containing two consecutive timestamp 
fields: the first specifying DATEISO format (resulting in a column with a heading such as 
"Start Date"), the second specifying TIMET or TIMES format ("Start Time"). The add-in 
combines the date and time into a single column (in the previous example, "Start Time") 
with the date and time values separated by a space. 

 If the add-in finds a time column before it finds a date column, it prompts the user to 
enter a date, and then prepends that date to the values in the time column. The add-in 
does not try to detect whether the time values cross date boundaries: it prepends the 
same date to all time values. This method is provided to support extracts created using 
report forms that do not include the date portion of the timestamp. It is recommended 
that you use report forms that include the date. 

 If the add-in does not find any of the above, it displays a box, and does not create a 
chart. 

• This add-in does not currently support date-only timestamps. 
• By default, the chart displays the first numeric or clock column on the Y-axis. So, if you use a 

report form to create the CSV file, place the fields that you are most interested in (such as 
response time) ahead of less important fields. 
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2. When charting a CSV file of statistics data: the add-in bases the chart X-axis on the values under 
the "Start Time" column heading.  values represent the statistics interval collection start time in 
a combined date/time format. 

3. Before creating the chart, the add-in sorts the data by the timeline (X-axis) column. 
4. The add-in opens your CSV file as a single worksheet. 
5. After using the add-in to create a timeline chart from the CSV file, you can save the generated 

workbook as an Excel workbook (.xlsx), and then re-open it later. The custom "Timeline Chart" 
toolbar only appears when the active workbook contains a timeline chart. 

6. You can send a workbook created by this add-in to other Excel users:  if they also have this add-
in installed, then they will be able to navigate the timeline chart using the custom toolbar. 
Otherwise, they will only see the chart in the state you last saved it. 

7. The add-in is not designed to support changes to the original data, with one exception: you can 
add new formula-based columns to the sheet, and then chart those columns by selecting their 
headings from the Data dropdown list of the custom toolbar, just like original data columns. For 
details on adding formula-based columns to a timeline chart, see "Scenario 6. Transaction 
statistics". 

8. The add-in excludes "TaskNo" and "VRM" from the dropdown list of chartable columns. 
9. To filter the chart data, click the AutoFilter arrows in the column headings on the Data sheet. 

Lost Timeline toolbar? 

If you cannot see the Timeline toolbar in a workbook that you created when doing this scenario, do 
the following steps: 

1. In Excel, choose File, on the right side, choose Properties > Advanced Properties, and click the 
Custom tab. 

2. Make sure there is a custom property called Timeline Chart, with a value of Yes. 
3. Close and reopen the Excel workbook. 

When you open the workbook, Excel checks whether this property is set to Yes, and if so displays 
the Timeline toolbar. You also need to have the CICS PA TCB Mode Analysis Excel add-in 
installed. 
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Scenario 6. Transaction statistics 
You can use the CICS PA Timeline Chart Excel add-in introduced in the previous scenario to chart 
CICS statistics data. This can help you to identify anomalies or patterns of activity in your CICS 
transactions. 

Here is an example timeline chart of Transaction Manager global statistics extracted from a CICS PA 
statistics HDB. To extract the same data, in a report set , under Extracts > Statistics, under Extract 
Focus, select Statistics Reports, and then activate Regions > Transaction Manager. 

 

Figure 24. CICS PA Timeline Chart Excel add-in: charting a statistics data extract 

Notice the data column heading "Peak Tasks As % Of MAXTASKS" highlighted in the figure. This 
column does not exist in the CSV file originally created by CICS PA: we added it later. 

To add a new column to the Data sheet of a timeline chart workbook: 

1. Display the Data sheet in Excel. 
2. Insert a new blank column: select an existing column (for example, by clicking the letter above 

the column heading), right-click and click Insert > Columns. 
3. Enter a column heading in the first row of the new column. 
4. Enter a formula into the second row of the new column. For example, if Column N is Peak Active 

User Transactions and column I is Current MAXTASK, enter: 

=N2/I2*100 

The "Insert formula-based 
columns" toolbar button allows 
you to add formula-based 
columns defined in another 
workbook. The additional 
columns appear in the dropdown 
list with the original columns.
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Note: In Excel 2007, the Accept Labels in Formulas propery was deprecated so, in subsequent 
versions of Excel, you cannot refer to columns using their column headings; you must 
cell references such as N2 instead. 

5. Double-click the fill handle (the small black square in the lower right corner) of the selected cell. 
This copies the formula and format to all used rows in the sheet. 

6. Click the "Chart" sheet tab to display the timeline chart sheet. The add-in automatically updates 
the dropdown list of chartable columns to include the new column. 

If you have previously saved a workbook that contains formula-based columns, and you now want to 
add these columns to a timeline chart that you have just created from a CSV file created by CICS PA: 

1. Open the timeline chart workbook to which you want to add the formula-based columns. The 
Data sheet in this workbook must not contain any formula-based columns. 

2. On the Timeline toolbar, click the "Insert formula-based columns..." button, which is the last 
button on the right. 

3. Select a workbook containing a worksheet that has the same headings as the Data sheet in the 
open timeline chart workbook, in exactly the same order, but with additional formula-based 
columns (these can appear in any column position; for example, in between original column 
headings). 

The workbook that you select could be a timeline chart workbook to which you have added 
formula-based columns, or it could be a workbook that you have created separately. If the 
workbook does not contain a sheet named "Data", the add-in uses the first sheet in the 
workbook. This sheet must contain at least two rows: headings on the first row, and formulas for 
the derived columns on the second row. For original columns, the second row can contain 
example values to test the formulas in the derived columns; otherwise, the values in the original 
columns are not significant. 

The add-in inserts the derived column headings and formulas from the selected workbook into 
the Data sheet of the open timeline chart. You can then select these new columns from the 
dropdown list of chartable columns, just like any of the original columns. 

To test this toolbar button, create a timeline chart from the supplied CSV file "CICS PA Timeline 
Chart - sample - hst010a.csv", click the "Insert formula-based columns..." button, and then 
select the supplied workbook "CICS PA Timeline Chart - derived column definitions - 
hst010a.xlsx". This inserts the new derived column "Peak Tasks As % Of MAXTASKS". 

When charting CICS statistics data, you will typically want to filter the data by the statistics interval 
collection type: for example, to only show INT intervals. To do this, click the AutoFilter arrows on the 
Data sheet: 

 

Figure 25. CICS PA Timeline Chart Excel add-in: filtering statistics data by interval collection type

Click the AutoFilter arrows
on the Data sheet to set 
filters on the chart data
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Appendixes 
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Appendix A. Transferring CSV files interactively 
To transfer a CSV file from the host to your PC interactively: 

1. Click the Start button on the Windows taskbar. 
2. Click Run... 

The Run dialog box appears. 

3. Enter cmd 

A command-line window appears. 

4. Enter ftp 

The ftp> prompt replaces the Windows command prompt. 

5. Enter open host 

where host is the computer name, IP address, or IPv6 address your /OS host. 

The FTP client attempts to open a connection to your z/OS host. If successful, a "Connected to..." 
message appears, followed by a prompt for your user ID. (If the "Connected to..." message does 
not appear, contact your system administrator.) 

6. Enter your TSO user ID, and then your password. 
7. Enter ascii 

This instructs FTP to transfer files as text, and to perform any character set conversion 
necessary: in this case, we want to transfer our EBCDIC-encoded CSV data set to the PC as an 
ASCII-encoded (plain text) file. 

Now we are ready to transfer the file from the host. 

8. Enter get host_dsn local_file_path 

where: 

host_dsn 

Fully qualified data set name of the CSV data set (or PDS member) that you want to transfer, 
including enclosing single quotes. (If you omit the enclosing quotes, then FTP prepends your 
user ID as a high-level qualifier.) 

local_file_path 

Absolute path of the destination file on your PC. If the path contains spaces, then enclose 
the path in double quotes. 

For example: 
get 'MYID.CICSPA.CSV(TEST0001)' "C:\My Downloads\test0001.csv" 
If the transfer is successful, a "Transfer completed successfully" message appears. 

9. Enter quit 

This ends the FTP session, and returns you to the Windows command prompt. 

10. Enter exit 

This closes the command-line window. 
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Appendix B. Distributing QMF for z/OS objects via PC 
Some of the supplied files have the extension ".qmf". These are QMF for z/OS objects that have 
been exported to data sets, and then transferred as text files to PC, so that they can be distributed 
to you in a .zip file. To use these .qmf files, you must transfer them to z/OS, and then import them 
into QMF. A Windows script and a QMF procedure are supplied to help automate these steps, as 
described in "Scenario 3. Tuning LSR buffer pools". 

To enable you to distribute your own QMF for z/OS objects, the supplied files also include the scripts 
for exporting QMF objects and transferring them to your PC. This provides you with the ability to 
"round-trip" QMF objects between your z/OS host and your Windows PC. 

You can use the QMF procedure (supplied in CPA_LSR_PORT_P.qmf) to import or export QMF 
objects. 

To put a set of .qmf files onto a z/OS host via FTP, run the supplied Windows script "Transfer QMF 
objects - put onto host.wsf". The script must be in the same folder as the .qmf files. 

To get all the data sets under a specified high-level qualifier from a z/OS host via FTP, and save them 
as .qmf files, run the supplied Windows script "Transfer QMF objects - get from host.wsf". This saves 
the .qmf files to the same folder as the script. 

Both Windows scripts rely on a common VBScript code module, "Transfer QMF objects - code.vbs". 
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Appendix C. List of supplied sample files 
Here is a list of the files supplied with this SupportPac: 

Licenses/Lic_*.txt 

Software license agreement in various languages, in plain-text. The English version is Lic_en.txt. 

cp12.pdf 

This document, in Adobe PDF format. 

CICS charts - macros.xlsm 

Excel workbook containing macros that create the charts for “Scenario 1. Are we meeting 
service-level agreements?” and “Scenario 2. Why is a transaction slow?” 

CICS charts - scenario 1 - example.xlsx 

Excel workbook containing example charts for “Scenario 1. Are we meeting service-level 
agreements?” 

CICS charts - scenario 1 - example.csv 

Plain-text comma-separated value (CSV) file containing sample data for “Scenario 1. Are we 
meeting service-level agreements?” 

CICS charts - scenario 1.bat 

Batch file that calls the Windows script file (below) that calls the Excel macro for “Scenario 1. Are 
we meeting service-level agreements?”. Together with the Windows script file, this 
demonstrates how to automate chart creation without any user interaction. For details on this 
approach, see " Running the macro from scripts and batch files ". 

CICS charts - scenario 1.wsf 

Windows script file that calls the Excel macro for “Scenario 1. Are we meeting service-level 
agreements?” 

CICS charts - scenario 2 - example.xlsx 

Excel workbook containing example charts for “Scenario 2. Why is a transaction slow?” 

To create these charts yourself, open "CICS charts -macros.xlsm", run the macro 
SamplePerformanceChartSet, and select the supplied CSV file "CICS charts - scenario 2 – sample 
performance data.csv". 

CICS charts - scenario 2 - sample performance data.csv 

Plain-text comma-separated value (CSV) file containing sample data for “Scenario 2. Why is a 
transaction slow?” 

CPA_LSR_*.qmf 

Plain-text files containing exported QMF objects for "Scenario 3. Tuning LSR buffer pools". 

batch-QMF-JCL.txt 

Sample JCL for "Scenario 3. Tuning LSR buffer pools". 

CICS PA Compare Before-After.xlam 

CICS PA Compare Before-After Excel add-in for "Scenario 4.  Comparing current and previous 
CICS performance". 



 

70    SupportPac CP12: Charting Historical CICS Performance Data 

CICS PA Compare Before-After - after.csv 

Sample CSV file for use with the CICS PA Compare Before-After Excel add-in. 

CICS PA Compare Before-After - before.csv 

Sample CSV file for use with the CICS PA Compare Before-After Excel add-in. 

CICS PA Compare Before-After - sample.xlsx 

Excel workbook created by the CICS PA Compare Before-After Excel add-in. 

CICS PA TCB Mode Analysis.xlam 

CICS PA TCB Mode Analysis Excel add-in for "Scenario 5.  Threadsafe performance issues: TCB 
CPU usage and change modes". 

CICS PA TCB Mode Analysis - sample.csv 

Sample CSV file of performance summary data for use with the CICS PA TCB Mode Analysis Excel 
add-in. This CSV file was created using the sample report form CPU5SEXT supplied with CICS PA. 

CICS PA TCB Mode Analysis - sample.xlsx 

Excel workbook created by the CICS PA TCB Mode Analysis Excel add-in. 

CICS PA Timeline Chart.xlam 

CICS PA Timeline Chart Excel add-in for "Scenario 5. Threadsafe performance issues: TCB CPU 
usage and change modes" and "Scenario 6. Transaction statistics". 

CICS PA Timeline Chart - derived column definitions - hst010a.xlsx 

Excel workbook containing a worksheet with columns that match a CSV file created by CICS PA 
from Transaction Manager statistics (for example, CICS PA Timeline Chart - sample - 
hst010a.csv), plus a new "derived" column whose values are defined by a formula. This 
workbook is for use with the "Insert formula-based columns..." button on the Timeline toolbar. 

For details, see "Scenario 6. Transaction statistics". 

CICS PA Timeline Chart - sample – cpu5lext.csv 

Sample CSV file of performance list data for use with the CICS PA Timeline Chart Excel add-in. 
This CSV file was created using the sample report form CPU5LEXT supplied with CICS PA. 

CICS PA Timeline Chart - sample - hst010a.csv 

Sample CSV file of statistics data for use with the CICS PA Timeline Chart Excel add-in. This CSV 
file contains Transaction Manager statistics extracted from a CICS PA statistics HDB. 

Query zOS-based DB2 table.xlsm 

Excel workbook containing a rudimentary macro function for querying a z/OS-based DB2 table. 
You can use this function to test your connection to DB2 tables on z/OS. For details, see " Testing 
the connection from Excel to DB2". 

Transfer QMF objects - *.* 

Scripts to transfer exported QMF objects between z/OS and Windows. For details, see Appendix 
B, "Distributing QMF for z/OS objects via PC". 
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Appendix D: Notices and Trademarks 
Notices 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. 
Consult your local IBM representative for information on the products and services currently 
available in your area. Any reference to an IBM product, program, or service is not intended to state 
or imply that only that IBM product, program, or service may be used. Any functionally equivalent 
product, program, or service that does not infringe any IBM intellectual property right may be used 
instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM 
product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not give you any license to these patents. You can 
send license inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 

The following paragraph does not apply to the United Kingdom or any other country where such 
provisions are inconsistent with local law:  
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions; therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions of 
the publication. IBM may make improvements or changes in the products or programs described in 
this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do 
not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are 
not part of the materials for this IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including 
this one) and (ii) the mutual use of the information which has been exchanged, should contact: 
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IBM United Kingdom Limited 
Intellectual Property Department 
Hursley Park 
Winchester SO21 2JN 
United Kingdom 

Such information may be available, subject to appropriate terms and conditions, including, in some 
cases, payment of a fee. 

The licensed program described in this information and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License 
Agreement, or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measures may have 
been made on development-level systems, and there is no guarantee that these measurements will 
be the same on generally available systems. Furthermore, some measurements may have been 
estimated through extrapolation. Actual results may vary. Users of this document should verify the 
application data of their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements or other publicly available sources. IBM has not tested those products 
and cannot confirm the accuracy of performance, compatibility or any other claim related to non-
IBM products. Questions on capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

This information contains examples of data and reports used in daily business operations. To 
illustrate them as completely as possible, the examples include names of individuals, companies, 
brands, and products. All of these names are fictitious and any similarity to the names and addresses 
used by an actual business enterprise is entirely coincidental. 

Trademarks 

The following terms are trademarks of International Business Machines Corporation in the United 
States, other countries, or both. 

• CICS 

• DB2 

• DB2 Connect 

• IBM 

• MVS 

• QMF 

• Query Management Facility 

• SupportPac 

• Tivoli 

• OMEGAMON 

• WebSphere 
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• z/OS 

Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United 
States, other countries, or both. 

Other company, product, and service names may be trademarks or service marks of others. 
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